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1. ISP Programming Conn : A socket for the ISP Programmer, which allows easy insertion/removal or 
                           in-system  programmer.

2. Power I/P (Power Input):This is the power supply input to the board, providing necessary +5V voltage 
      from USB C connector to power the board when programmer is not connected.
4. 8051 MCU: Any 8051 based 40 Pin DIP IC can be used with this board. This board is equipped with 89S52.

11. Digital 2 I/P Button Switches: 2 Push buttons serve as digital input switches connected to P1.2 and P1.3.
  When configured as Inputs, they are pulled up at level High. On pressing, 
  they are connected to ground and making Pins State as Low. 

7. UDB Conn:These connectors are used to attach this kit to ‘Universal Development Board(UDB)’ 
                        by Amotech Labs. Check UDB details on our website.
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 ‘8051 Mini Development Board’ can be mounted on below UDB Kit:   
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 ‘8051 Mini Development Board’ mounted on UDB Kit’s Slot 1 can be seen in the below    
 UDB Kit which has DC, Servo and Stepper Motors mounted on-board.    

Note: This Kit was assembled for College Lab use in Wooden Box Enclosure. That’s why it is fitted on      

 For Students, only UDB  is also available to buy with ‘UDB 2 Wheel Robot  Acrylic Sheet’.     
 Students can configure the UDB by adding the peripherals as per their application needs.      

          a Acrylic Sheet with Motors mounted on it for studying their interfacing using 8051 MCU & UDB.     



 Introduction to AT89S52 Microcontroller

:  

Features of AT89S52: 

✓ Operating Frequency :  DC - 33 Mhz

✓ Program Memory (Bytes): 8K

✓ Program Memory (Instructions) : 8192 

✓ Data Memory (Bytes): 256

✓ Data EEPROM Memory (Bytes) :  Not Availabe 

✓ Interrupt Sources: 6 

✓ I/O Ports : Ports 0,1,2,3 

✓ Timers : 3(16 bit each) 
✓ Capture/Compare/PWM Modules : No 

✓ Enhanced Capture/ Compare/PWM Modules : No

✓ Serial Communications : MSSP, Addressable UART

✓ Universal Serial Bus (USB) Module : No

✓ Streaming Parallel Port (SPP) : No 

✓ 10-Bit Analog-to-Digital Module : No 

✓ Comparators : No 

✓ Programmable Low-Voltage Detect :  No 

✓ Instruction Set :255

✓ Packages :  40-pin DIP, 44-pin PLCC , 44-pin TQFP
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2. ‘Create New Project’ window will pop up, type a project name and location for the project and save.

 Below are the steps to program any AT89S52 code.

 1.Select New µVision Project from the Project Menu.           
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       Keil IDE for Programming of 8051 (AT98S52) MC



3.

4. . 
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“Select Device for Target” window will pop up, select your device (here we selecting AT89S52).

 “µVision” window will ask for copy STARTUP.A51 to the project folder and add a file to the project
(If necessary you can select “No” but we recommended you to select “Yes” because 
it will help to run the program smoothly. )



5. 
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. Now select New file from the File menu and type your program co de (here we have typed LED   
  blinking program)

6.Save program code with “.c“ extension (In case if you are using assembly language then save



7.
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Right-click on Source Group 1 folder from Target 1 and select “Add existing files to Group 'Source Group 1'”

8. Select the program file saved with “.c “or “.asm” (in case of assembly language) and add it. Then close 
   that window. You can see the added file in the “Source Group 1” folder in the left project window.
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9.Now select the Project menu and click on “Build target”, it will build a project and give status in the 
Buildoutput window with Error and Warning count if any

10.To create a Hex  file right click on Target 1 and select Option for Target 'Tar



12.Within the same window select the “Output” option and tick mark in front of the “Create Hex 
File” tag and click on OK.
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11. The target window will pop up, enter Xtal (MHz) frequency (here we used 11.0592 
MHz), and tick mark in front of the “Use On-chip ROM” tag.
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 13. Again select build target from the Project menu or simply hit the F7 shortcut key for the same,
it will build target and also create a Hex file. You can see creating a Hex file in the Build output 
window

14. Check Video Tutorials on our YouTube Channel, for Instructions of Installing ISP Programmer    
      Drivers, Compiling the program and Downloading the Hex File into our 8051 Development Boards.   

                                           In Videos for ‘8051 Development Boards’, under their description you will also find a Google Drive Link 

      YouTube Channel:                                               https://www.youtube.com/@AmotechLabs

                                           to download ISP Programmer, Drivers, Programmer Software Files, Sample Programs and Schematic. 



     

            Lab 1 - LED Blinking                                                                            

  Aim: To study the LED’s Interfacing with AT89S52 mini development board.  

 

Procedure:

1. Read the LED Blink Program on the next page with all the comments explaining the code.
2. Open the Project folder in Keil µVision IDE or create a new project following the Keil manual. 
3. Build the project and generate the HEX file.Use Keil Programmer or another suitable tool to 

download the HEX file to the 8051 microcontroller.
4. Open the Progsip and load the hex file of the program and then run the program.                                       
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Program:

1.  #include<reg52.h>// special function register declarations
2.  LED1 = P1^ ; sbit 0 //LED1 pin
3.   LED2 = P1^ ; sbit 1 //LED2 pin
4. delay(  count); void unsigned int
5.  main ( ) void void
6.  {
7.   (1) while // infinite loop
8. {  
1.    = 0;LED1
2.     = 1;LED2
3.    (1000);delay
4.     = 1;LED1
5.     = 0;LED2
6.    (1000);delay
7.  }
9.  }
10. //delay function generates delay in millisecond.
11.  delay(  count)void unsigned int
12. {
13.  i,j;int 
14.  (i=0;i<count;i++)for
15.  (j=0;j<112;j++);for
16. }



     

   

      
                                                                        
 

 Aim: To study the 16x2 LCD Interfacing with AT89S52 mini development board.  

 

Procedure:  

1. Read the LCD Interfacing Program with all comments explaining the code. 
2. Open Keil µVision, create/open a project for 8051 (AT89C51), write the program, and build it to 

generate the Hex file.
3. Use Progsip to download the Hex file to the 8051 microcontroller.
4. Adjust the LCD contrast using the 10k pot. Once programmed and disconnected, the expected 

content will appear on the LCD.                                     
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            Lab 2 - LCD Interfacing                                                                            
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Program:

  1   #include<reg51.h>
  2   D7=P3^ ;  sbit 7 //LCD D7
  3    D6=P3^ ; sbit 6 //LCD D6
  4    D5=P3^ ;sbit 5 //LCD D5
  5    D4=P3^ ; sbit 4 //LCD D4
  6    rs=P3^ ;  sbit 2 /* RS Register select pin */ //Ard D8
  7    en=P3^ ;  sbit 3 /* EN Enable pin */ //Ard D7
  8    LCD_Port;int
  9   
 10   /* Function to provide delay Approx 1ms with 11.0592 Mhz crystal*/
 11   delay(  count) void unsigned int
 12   {
 13    i,j;int
 14   (i=0;i<count;i++)for
 15  (j=0;j<112;j++); for
 16   }
 17   
 18    LCD_Command (  cmnd)void char  /* LCD16x2 command funtion */
 19   {
 20   LCD_Port =(cmnd&0xF0)>>4; /* Send upper nibble */
 21   =LCD_Port&0X ;D7 08
 22   =LCD_Port&0X ;D6 04
 23   =LCD_Port&0X ;D5 02
 24  =LCD_Port&0X ; D4 01
 25   rs=0;     /* Command reg. */
 26     // rw=0; /* Write operation */
 27   =1;en
 28   (1);delay
 29   =0;en
 30  (2); delay
 31   
 32   =(cmnd&0x ); LCD_Port 0F  /* Send lower nibble */
 33   =LCD_Port&0X ;D7 08
 34  =LCD_Port&0X ; D6 04
 35   =LCD_Port&0X ;D5 02
 36   =LCD_Port&0X ;D4 01
 37   =0;rs
 38   =1;en /* Enable pulse */
 39  (1); delay
 40   =0;en
 41   (5);delay
 42   }
 43
 44   LCD_Char ( _data)void charchar  /* LCD data write function */
 45   {
 46   LCD_Port =( data&0x )>>4; char_ F0 /* Send upper nibble */



19

AMOTECH LABS
Sharing Enthusiasm for Embedded Systems & Automa�on. 

 +91-8329537565  amotechlabs@gmail.comwww.amotechlabs.com

 Embedded/IoT Development | Automa�on Sevices | Training & Counselling
 Embedded Development Boards/Kits |PLC & Automa�on raining Staa�onsAMOTECH

     LABS

 

 47  =LCD_Port&0X ; D7 08
 48   =LCD_Port&0X ;D6 04
 49  =LCD_Port&0X ; D5 02
 50  =LCD_Port&0X ; D4 01
 51   =1; rs /*Data reg.*/
 52   // rw=0; /*Write operation*/
 53   =1;en
 54   (1);delay
 55  =0; en
 56  (2); delay
 57   
 58    =( _data&0x ); LCD_Port 0Fchar /* Send lower nibble */
 59   =LCD_Port&0X ;D7 08
 60  =LCD_Port&0X ; D6 04
 61   =LCD_Port&0X ;D5 02
 62   =LCD_Port&0X ;D4 01
 63   =1; en /* Enable pulse */
 64   (1);delay
 65   =0;en
 66   (5);delay
 67   }
 68   
 69   LCD_String ( str) void char*  /* Send string to LCD function */
 70   {
 71    I; int
 72     (i=0;str[i]!=0;i++) for  /* Send each char of string till the NULL */
 73      {
 74     LCD_Char(str[i]); /* Call LCD data write */
 75     }
 76   }
 77 
 78   LCD_String_xy ( row,  pos,  *str)  void char char char /* Send string to LCD function */
 79   {
 80     (row == )if  0
 81       LCD_Command((pos & 0x )|0x );0F 80
 82       (row == ) else if 1
 83       LCD_Command((pos & 0x )|0x );0F C0
 84       LCD_String(str);  /* Call LCD string function */  
 85   }
 86   LCD_Init ( ) void void /* LCD Initialize function */
 87   {
 88     (20);  delay  /* LCD Power ON Initialization time >15ms */ 
 89 LCD_Command (0x ); 02  /* 4bit mode */
 90 LCD_Command (0x ); 28  /* Initialization of 16X2 LCD in 4bit mode */
 91 LCD_Command (0x );0C  /* Display ON Cursor OFF */
  /* Auto Increment cursor */92 LCD_Command (0x );06
 /* clear display */93 LCD_Command (0x ); 01
 94  LCD_Command (0x ); 80 /* cursor at home position */
 95 }
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  98   main() void
  99   {
100    LCD_Init(); /* Initialization of LCD*/
101     LCD_String("8051 Mini Kit");/* write string on 1st line of LCD*/
102     LCD_Command(0x );c0  /* Go to 2nd line*/
103     LCD_String("by AMOTECH LABS");/*write string on 2nd line*/
104     (1000);delay
105     (1);while  /* Infinite loop. */
106   }

 



           
                                                                        
 

 Aim: To study the Interfacing of 4x4 Keypad with AT89S52 mini development board.  

 

 

1. Read the Keypad Interfacing Program on the next page with all the comments explaining 
the program.

2. Open the Project folder for the program in Keil µVision IDE or create a new project 
following the procedure explained in the Keil manual. Build the project and generate the 
HEX file. 

3. Use Keil Programmer or another suitable tool to download the HEX file to the 8051 
microcontroller.             

4. If you entered the correct passkey then you will get acess otherwise you will get the 
message “Access denied”.                            
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            Lab 4 - 4x4 Keypad Interfacing                                                                            

Procedure:
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Program:

1. #include<reg51.h>
2. #include<string.h>
3.  lcdport #define P3
4.
5.  col1=P2^ ;sbit 3
6.  col2=P2^ ;sbit 2
7.  col3=P2^ ;sbit 1
8.  col4=P2^ ;sbit 0
9.  row1=P2^ ;sbit 7
10.  row2=P2^ ;sbit 6
11.  row3=P2^ ;sbit 5
12.  row4=P2^ ;sbit 4
13.  =P3^ ;sbitrs 2
14. en=P3^ ;sbit 3
15. buzzer=P1^ ;sbit 0
16. pass[ ],i= ;char 4 0
17.
18. delay(  itime)void int
19.{
20.    i,j;int 
21.    (i=0;i<itime;i++)for
22.  (j=0;j<1275;j++);  for
23.}
24. daten()void 
25.{
26.    rs= ;1
27.    en= ;1
28.    delay( );5
29.    en= ;0
30.}
31. lcddata(unsigned char ch)void 
32.{
33.    lcdport=ch & 0x ;f0
34.    daten();
35.    lcdport=(ch<<4) & 0x ;f0
36.    daten();
37.}
38. cmden(void)void 
39.{
40.    rs= ;0
41.    en= ;1
42.    delay( );5
43.    en= ;0
44.}
45.. lcdcmd(  ch)void unsigned char
46. {
47.    lcdport=ch & 

48.    cmden();
49.    lcdport=(ch<<4) & 0x ;f0
50.   cmden();
51. }
52. lcdstring(  *str)void char
53. {
54.    (*str)while
55.    {
56.   lcddata(*str);
57.   str++;
58.    }
59. }
60. lcd_init(void)void 
61. {
62.    lcdcmd(0x );02
63.   lcdcmd(0x );28
64.   lcdcmd(0x );0e
65.    lcdcmd(0x );01
66.}
67. keypad()void 
68.{
69.    int cursor= ,flag= ;192 0
70.    lcdcmd( );1
71.    lcdstring( );"Enter Ur Passkey"
72.    lcdcmd(0x );c0
73    i= ;0
75. (i<4)while
76.    {
77.    flag=cursor;
78.     col1= ;0
79.     col2=col3=col4= ;1
80.    (!row1) if
81.     {
82.       lcddata( );'1'
83.        pass[i++]='1';
84.        cursor++;
85.        (!row1);while
86.      }
87. (!row2)else if
88.     {
89.        lcddata( );'4'
90.       pass[i++]=' ';4
91.        cursor++;
92.        (!row2);while
93.        }
94.  (!row3)else if
95.   {
96.        lcddata( );'7'
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Program:

97.  pass[i++]='7';
98.        cursor++;
99.      (!row3);while
100.   }
110 (!row4)else if
111.   {
112.       lcddata( );'*'
113.        pass[i++]='*';
114.        cursor++;
115.      (!row4); while
116.        }
117.     col2=0;
118.     col1=col3=col4=1;
119.     (!row1)if
120.     {
121.        lcddata('2');
122.        pass[i++]='2';
123.        cursor++;
124       (!row1); while
125.        }
126. (!row2) else if
127.     {
128.        lcddata('5');
129.        pass[i++]='5';
130.        cursor++;
131.        (!row2);while
132.        }
133.      (!row3)else if
134.     {
135.        lcddata('8');
136.        pass[i++]='8';
137.        cursor++;
138.       (!row3); while
139.        }
140.      (!row4)else if
141.     {
142.        lcddata('0');
143        pass[i++]='0';
144.        cursor++;
145.       (!row4); while
146.        }
147.     col3= ;0
148.     col1=col2=col4= ;1
149. (!row1)if
150.     {
151.        lcddata( ');'3

151. pass[i++]='3';
152.        cursor++;
153        (!row1);while
154.       }
155.      (!row2)else if
156.     {
157.       lcddata('6');
158.      pass[i++]='6';
159.        cursor++;
160.        (!row2);while
161.       }
162.    (!row3) else if
163.     {
167.        lcddata('9');
168.        pass[i++]='9';
169.       cursor++;
170.      while(!row3);
171.        }
172     (!row4)else if
173.    {
174.       lcddata('#');
175.        pass[i++]='#';
176.        cursor++;
177.        (!row4);while
178.        }
179. col4= ;0
180.  col1=col3=col2= ;1
181. (!row1) if
182.    {
183.        lcddata( );'A'
184        pass[i++]='A';
185.        cursor++;
186.       (!row1); while
187.        }
188.     (!row2) else if
189.    {
190.        lcddata( ');'B
191.        pass[i++]='B';
192.        cursor++;
193.        while(!row2);
194.        }
195. (!row3)else if
196.     {
197.        lcddata( ');'C
198.        pass[i++]='C';
199.        cursor++;
200.       (!row3); while
201        }
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Program:

202. (!row4) else if
203.     {
204.        lcddata( );'D'
205.        pass[i++]='D';
206.        cursor++;
207.        while(!row4);
208.          }
209.   (i>0)  if
210.     {
211.      (flag!=cursor)   if
212.         delay(100);
213.         lcdcmd(cursor-1);
214.         lcddata( );'*'
215.     } 
216. }      
217.}
218. accept()void 
219. {
220.    lcdcmd(1);
221.     lcdstring("Welcome");
222.     lcdcmd(192);
223.   lcdstring( );"Password Accept"
224.     delay(200);
225. }
225. void wrong()
226. {  buzzer=0;
227.            lcdcmd(1);
228.     lcdstring( );"Wrong Passkey"
229.    lcdcmd(192);
230.    lcdstring( );"PLZ Try Again"
231.    delay( );200
232.    buzzer= ;1
233. }
234. void main()
235. {
236.    buzzer= ;1
237.    lcd_init();
238.    lcdstring( );"AMOTECH LABS"
239.    lcdcmd(0x );c0
240.   lcdstring( );"   PUNE     “
241.   delay( );1000
242.    lcdcmd(1);
243.    lcdstring( ");"Electronic Code
244.    lcdcmd(0xc0);
245.    lcdstring( ");"  Lock System  
246.    delay( );400

247. (1) while
248.   {
249.            i=0;
250.            keypad();
251.           (strncmp(pass,"4201",4)== ) if 0
252.            {
253.            accept();
254.            lcdcmd( );1
255.            lcdstring( );"Access Granted "
256.            delay( );300
257.                }
258.         else
259.        {
260.           lcdcmd(1);
261.           lcdstring( );"Access Denied"
262.           wrong();
263.           delay( );300
264.        }
265.
266.    }
267. }



     

    Aim: To study the Interfacing of Digital Input Button with AT89S52 mini development board.  

 

Procedure:  

1. Read the Digital Input Button Program with comments explaining the code.
2. Open the Project folder in Keil µVision IDE or create a new project following the Keil manual. 
3. Build the project and generate the HEX file.Use Keil Programmer or another tool to download 

the HEX file to the 8051 microcontroller          
4. Open the Progsip and load the hex file of the program and then run the program.                               
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            Lab 3 - Digital Input Button                                                                            

  



Program:
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1.  <reg52.h>#include  // Include register definitions
2.   LED1 = P1^0; sbit // LED1 connected to P1.0
3.  LED2 = P1^1; sbit // LED2 connected to P1.1
4.   SW1 = P1^2; sbit // Switch 1 connected to P1.2 
5.  SW2 = P1^3; sbit // Switch 2 connected to P1.3 
6.  delay( count); void unsigned int 
7.   main( )void void
8.  {
9.   // Configure SW1 and SW2 pins as Input pins by writing 1 to them.
10.  //  After configuring them as Inputs pins, they will be pulled-up internally.
11. SW1 = ; 1
12.      SW2 = ;1
13. // Initialize LEDs to OFF state
14. LED1 = ;0
15.  LED2 = ;0
16. (1)while
17. {
18.  LED1 = Sw1;// After pressing SW1, Pin P1.2 wiil be Low making LED1 Low.
19.   delay( );50
20.   LED2 = Sw2;// After pressing SW2, Pin P1.3 wiil be Low making LED2 Low.
21.   delay( );50
22.  }
23. }
24. // Simple delay function (approximately 1ms per count)
25.  delay( count) {void unsigned int 
26. {
27.  I, j;unsigned int
28. (I = 0; i < count; i++) for
29.  (j = 0; j < 112; j++);for
30. }
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